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Public Viewing (Redaction) SOP

PURPOSE

The purpose of this document is to provide a uniform procedure used to redact sensitive

information (Personally Identifiable Information (PIl)) from a file during the scanning process

when the file is to be made available for public viewing.

1. Identify, assess and define the various document types that require redaction.

2. Define and document the specific criteria to redact documents based on predefined
parameters that adhere to DOT/Chief Counsel requirements.

SCOPE

This document describes the processes used to redact Pli from complaints and comments,
and documents of various types and formats that are received by the National Highway
Safety Administration (NHTSA) from consumers with regards to safety issues involving their
vehicles, tires, equipment, and/or child restraint systems.

Redaction is the process used to permanently delete or obscure sensitive information and
inappropriate or offensive language, from files, in accordance with the various privacy laws,
based on the Privacy Act of 1974 (the Privacy Act), the E-Government Act of 2002 (Public Law
107-347), the Federal Information Security Management Act (FISMA), Department of
Transportation (DOT) privacy regulations, Office of Management and Budget (OMB)
mandates, and other applicable DOT Records Management procedures and guidance.

ARTEMIS (Advanced Retrieval, Tire, Equipment and Motor Vehicle Information System) is the
database and Image Repository System developed to enable ODI managers, writers,
screeners, analysts, investigators and engineers to meet statutory obligations and reporting
requirements by storing complaint documents and making data accessible both privately
(internal only) and publicly (internet accessible) in separate repositories.

The Public Image Repository allows review of these documents, after redaction, by the
public; it is accessible on the Internet at http://artemis.odi.nhtsa.dot.gov/

ROLES AND RESPONSIBILITIES

Document Handlers:

e  Redact information (P1l), delete inappropriate or offensive language and add
disclaimers, in accordance with this policy (SOP).

e Quality Control all documents twice before uploading to the Public Repository. (Quality
Control is performed by someone other than the person making the initial redactions).

¢ Upload documents to the Public Repository.

e Maintain a Completion Log, in spreadsheet format, tracking; Receipt Date, Status
(Public or Private Repository) and Completion Date.
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Public Viewing (Redaction) SOP

IV. EXPERIENCE REQUIREMENTS
N/A
V. PROCESSING INFORMATION and POLICY

Document Handling for Redaction

Documents come to NHTSA in several forms; all must be subjected to the redaction process
so that when made available to the public, individual privacy is maintained. How and where
redaction is accomplished depends on the form in which the document is received, either in
hardcopy or electronic format.

Hardcopy Format (Paper)

Must be scanned to a PDF-format and stored in the Artemis database. Before entering
documents in Artemis, each document is redacted, in the Acrobat application, and then
saved to the Artemis database, after a Document ID is assigned, by the ARTEMIS application
the ID number facilitates easier searching and helps keep track of the particular complaint.
Two Quality Control checks are done before uploading to the Artemis Public Repository
where it can be view by the public. Quality control is completed by another person other
than the person making the initial redactions.

Note: When redacting ‘personally identifiable information” (PIl) on a document
scanned into Acrobat, the document is reviewed, then the Pli is covered with a black
box (as described in section VI How To Redact PIl).

Electronic Formats

¢ IVOQs — Internet Vehicle Owners Questionnaires - those entered directly in the Public
Repository of Artemis by the public, through the Internet.

e EVOQs - Electronic Vehicle Owners Questionnaires those called into the Hotline and the
Hotline staff enters the information into Artemis.

e CD’s — Compact Discs - information may be in the form of a spreadsheet to be uploaded
into Artemis.

¢ Email - converted to PDF format then stored in Artemis.

These documents are be reviewed then redacted. (See the following lists for detailed
document type descriptions). Documents are then quality control checked (QC’d) before
uploading to the Artemis Public Repository or in the case of IVOQs and EVOQs they are taken
from Artemis then QC'd and redacted if necessary.

Note: When redacting ‘personally identifiable information” (Pll) on a document already
entered in Artemis (Electronic) review and replace redacted information with a bold
[XXX] (include brackets) so that the information is not identifiable.
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Public Viewing (Redaction) SOP

Note: Confidential and Petition materials must be brought to the attention of the
supervisor ASAP and the appropriate FTE staff assigned specifically to those materials
will examine them and determine if they can be placed in the Public Repository.

Note: In accordance with contractor and office policy, the file(s) are uploaded to the
Private or Public Repository or provided on a CD. A CD is prepared by request from the
Government customer only.

Types of records commonly received by OD!:
Hardcopy Records

Mailed-In Vehicle Owner’s Questionnaires (MVOQ) are questionnaires consumers
use to report problems with their vehicles, tires, equipment, and or child restraint
systems. This includes a consumer submitting additional information in support of an
electronically submitted or telephoned VOQ (see below).

Police Accident Report (PAR) is reports taken by law enforcement officers regarding
a vehicle accident or defect resulting in a traffic hazard. PARs may include contact
information for the consumer, as well as fatality, personal injury, property damage,
weather conditions, primary causation factors, as well as:accident and fatality ratio
information.

Correspondence Letter/Consumer Letter is written information about a consumer
complaint often with supporting documentation such as letters, invoices and/or
pictures.

Court Documents are official court records generally submitted by a consumerin
support of a VOQ.

Medical Records include reports and other supporting medical documentation
provided by the consumer.

Automotive service invoices and records are documents related to automotive
repair, service invoices and records provided to the consumer.

Photographs are hardcopy images provided by the consumer.

Electronic Records

Internet Vehicle Owner’s Questionnaire (IVOQ) is a complaint form generated by a
consumer on the NHTSA website on which they report a problem with a vehicle,
tires, vehicle equipment and or child restraint systems.

Electronic Vehicle Owner’s Questionnaire (EVOQ) is a complaint telephoned to the
Vehicle Safety Hotline. Hotline staff receives calls and enters information provided
by the consumer into the Artemis database. The information entered in Artemis is
electronically captured on an EVOQ.

Manufacturer’s Information Request Response is databases and or spreadsheets
sent to NHTSA provided by a manufacturer, usually on compact disc, in response to
ODI’s information request.

Electronic Mail (E-mail) is electronic mail correspondences relative to NHTSA and/or
ODI activities.
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Public Viewing (Redaction) SOP

Redacting Personally Identifiable Information (Pll) and Offensive Language

The use of inappropriate or offensive language in the context of the Complaint Description
section should be brought to the attention of the Supervisor for determination of further
action (editing, retain original text, review by Artemis Program Manager, review by the
Director of CRD, referral to Chief Counsel’s Office, etc.)

Inappropriate or offensive language includes, but is not limited to, any language or content
that is sexually oriented, sexually suggestive or abusive, harassing, defamatory, vulgar,
obscene, profane, hateful, or that contains racially, ethnically or otherwise objectionable
material of any kind.

Should an item in the Description field be deemed to contain inappropriate or offensive
language, the text should be removed and replaced with “!@#5%” .

The following chart (Figure 1) lists the information to be redacted for the major document
types as well as information not to redact, according to the policy set by NHTSA’s Chief
Counsel Office.
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Public Viewing (Redaction) SOP

Document Types

Information Redacted

Not Redacted

Consumer Complaints/
Correspondence
letters/Congressional
letters/Petition
letters/Newspaper
excerpts/Other supporting
documents

Names

Street addresses

Zip or postal codes

Social Security numbers

Dates of birth

Ages

Driver’s license numbers

Family/friend names
Faces/injuries/deceased bodies in photos
Car tags or license plate numbers
(private vehicles only)

Phone numbers — home, business, fax and
mobile numbers

Signatures from the consumer, family,
friends, or witnesses

Insurance claim numbers

Insurance policy numbers
Warranty/Invoice claim numbers
Junkyard/Insurance claim centers stock
numbers (usually painted on vehicles)
Bank account numbers

Credit card numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

VIN barcode {part of barcode}

Citation numbers

Police accident report case number
Court reference numbers

State

City

First 11 characters of

VIN number

Car tags or license

plates of commercial vehicles
Names and

addresses of parties acting in their
official capacity (e.g., lawyers, doctors,
automobile dealers, automotive
service businesses,

police officers, EMT,

coroners, nurses,

government officials,

Judgesetc.)
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Death Certificates, Autopsy
Reports or other information
related to deceased individuals

Names

Street addresses

Zip or postal codes

Social Security numbers

Dates of birth

Ages

Driver’s license numbers

Family/friend names
Faces/injuries/deceased bodies in photos
Car tags or license plate numbers
(private vehicles only)

Phone numbers — home, business, fax and
mobile numbers

Signatures from the consumer, family,
friends, or witnesses

Insurance claim numbers

Insurance policy numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

VIN barcode (part of barcode)

Citation numbers

Police accident report case number

Any unique identifier for death
certificates/autopsy reports {(e.g. Report
number)

State

City

First 11 characters of

VIN number

Car tags or license

plates of commercial vehicles
Names and

addresses of parties acting in their
official capacity (e.g., lawyers, doctors,
automobile dealers, automotive
service businesses,

police officers, EMT,

coroners, nurses,

government officials,

Judges etc.)

Medical Records, such as, doctor

Replace with disclaimer page

Replace with disclaimer page

reports and medical reports (See page 8) (See page 8)

Work Orders/Repair Names State

Invoices/Warranty Street addresses City

information/Insurance claims Zip or postal codes First 11 characters of
Social Security numbers VIN number

Dates of birth

Ages

Driver’s license numbers
Family/friend names

Car tags or license plate numbers
(private vehicles only})

Customer phone numbers — home, business,
fax and mobile numbers
Signatures from the customer
Insurance claim numbers
Insurance policy numbers

Bank account numbers

Credit card numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

Car tags or license

plates of commercial vehicles
Names and

addresses of parties acting in their
official capacity {e.g., lawyers, doctors,
automobile dealers, automotive
service businesses,

police officers, EMT,

coroners, nurses,

government officials,

Judges etc.)
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Lawsuit Documents
(Depositions, complaints, other
supporting documents etc.)

Names

Street addresses

Zip or postal codes

Social Security numbers

Dates of birth

Ages

Driver’s license numbers

Family/friend names
Faces/injuries/deceased bodies in photos
Car tags or license plate numbers

{private vehicles only)

Phone numbers — home, business, fax and
mobile numbers

Signatures from the consumer, family,
friends, or witnesses

Insurance claim numbers

Insurance policy numbers
Warranty/invoice claim numbers
Junkyard/Insurance claim centers stock
numbers (usually painted on vehicles)
Bank account numbers

Credit card numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

VIN barcode (part of barcode)

Citation numbers

Police accident report case number
Accident incident date

Mile markers

Street names (where the accident occurred)
Pl in lawsuit caption if Pll is of individuals not
acting in official/commercial capacity
Court reference number

Witness PIl: e.g. name, address, telephone,
DOB, faces, signatures etc.

Lawyers involved in the lawsuit Names
and addresses of commercial
organizations

Names and

addresses of parties acting in their
official capacity (e.g., lawyers, doctors,
automobile dealers, automotive
service businesses,

police officers, EMT,

coroners, nurses,

government officials,

Judges etc.)

Page 7 of 35




Public Viewing (Redaction) SOP

Petition Information found in Petitioner’s address (including city and State) | Petitioner’s Name(s})
pursuits (i.e. DP investigation files)} Telephone number Names and
Zip or Postal Codes addresses of parties acting in their
Social Security numbers official capacity (e.g., lawyers, doctors,
Dates of Birth automobile dealers, automotive
Age service businesses,
Driver’s License numbers police officers, EMT,
Family/Friend names coroners, nurses,
Third-party names and witness information government officials,
Street Addresses Judges etc.)

Faces/injuries/deceased bodies in photos
Car tags or license plate numbers Phone
numbers, home, business, fax and mobile
numbers

Signatures from the consumer, family,
friends, or witnesses

Insurance claim numbers

Bank account numbers

Credit card numbers

Last 6 digits of the VIN

E-mail addresses

Foreign VIN last 6 digits

VIN barcode {part of barcode}

Figure 1 — Table describing information to redact or not redact according to the document type
and per current redaction policy.

For Medical Records and Videos
Instead of redacting Pl for medical records and videos, replace the entire file with the
appropriate disclaimer page.

For medical report files: For Videos:

To protect the privacy of
individuals, NHTSA does not
make Videos that contain
Personal Identifying Information
available to the public without
authorization. For this reason,
Videos falling into this category
have not been included in this
complaint records.

To protect the privacy of
individuals, NHTSA does not
make medical records available
to the public without
authorization. For this reason,
documents falling into this
category have not been included
in this complaint record.
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Vil. Add Disclaimer

After redacting a document, place a Disclaimer (redaction policy) on the page. Choose the
disclaimer statement according to the correct exemption (see Exemption List (page 11).
Choose placement of the disclaimer according to document type, see the following examples.

L Aorvrek: LR Ha JIZA0E)
e DOT Auto Safety Hotline FOR AGENCY USE ONLY 100148

US. Departmant Vehicle Owner's Questionnaire Dste Recemed Reposttory []

of Transportation To Report Vehicie Safety Defects

:::z‘ w"zm Y 1{:':::3:?;::23: : 15-JUN-2010 Reference Mo,
Administration INTERNET:www.nhtsa.dot.gov/hotline e

OWNER INFORMATION (Type of Print}

Nams | XXX SEOCMAD | Drorraral e | TRkt b con

EX BN X | = N
KY  DRARAESNXX ] I"'“ M |l"°°“o1m mﬂn
The information mﬂh“bmmw -ralated dulscts. %MMMWWM
w % ARt foutive Usns Sascriband In Ihe apancy's Privacy At
suma s:mt!u.l I
YEMICLE INFORMATION
17 dight Vetice Iduifiation Number Logatsd # barom of windshied on drivers s | Maka Model Modal Yaxr
SHGCMGE SX4AD0 7800 HOMNDA ACCORD 2004
Diate Purchased Daxsfar's Hama and Taephone Mumber Engina: Foal Type:
Mo: Tylndess 6
Originad Ownes Dealrs Tty SAate 2ip Code
Travsavigsion Type {[ | Antiiock Brakes] powaertzals #ultipie Fagure: Incident Duate(s}
] Craise Controi t 10-113¢-2010

FAILED COMPONENT(S)/PART(S) INFCRMATION
Vahick Commponent Coda: 103000 POWER TRATY: AUTOMATIC TRANSMISSION

Failure Misage | Falure Spoed
F1000 6¢

Tire Make [ Twe mmm nmuuz tnsua(m P215/65K15)
[DOT Ho. (Exampie: DO THALSABOLYS) CJ Original X
] orlgo Eqpment [ Feture Location:
Tee o Code I Tie Fodure Typa:
ADDITIONAL ITEMS TO BE COMPLETED WHEN REPORTING A CHILD SEAT FAILURE
Maka; | Date Mtamsachues: | Mosel Bo Name:
Seat Type: [anstaitation Systen:
Chilt Set Compament Code: Fadod Part
Anum TNCIDENT msmmmn
(Fisds O i e Fakoney) Coach il et
Cragh Fue I Nunwﬂmsomkﬂuml Mmufbums w«mmpo«u

{] No
tiva Dencriptisn af Iacident{S), Crash{ea), and Enjury(ias).
Madse daacsibia (1) avants luading np o b Tailura, (2) Tallure and s consequanceds, sibd (3) what was doos to covect the Tallore
L8, party repaired or vighacad {sad i old part i svaliable)
WE WERE LUCKY THAT WE WEREN'T IKILLEDEI2004 HONDA ACTORD XA, 6CYL YINS{XNX]. WE WERE TRAVELING ON ROUTE 95 NORTH OF
BOSTON IN THE MIDOLE LANE AT AN APPROX. SPEED OF 60 MPH ON JUME 10, 2010 AT APPROX, 6:15PM. 1 WENT TO PASS THE CAR TN FRONT
OF US AMD STARTED TO PULL INTO THE PASSING LAKE OK THE LEFT. SUDDENLY, THE CAR JERKED YICLENTLY AND SLOWED DOWN
SUDDEMLY. THE CAR IN BACK OF US ALMOST HIT U5 AND SWERVED INTO THE LANE ON THE RIGHT TO AVOID HITTENG OUR CAR. THE
OTHER ORIVER WAS ALMOST RIUN GVER BY A SEMT TRUCK WHO JAMMED ON MIS BRAKES. 1 THOUGHT HE (THE TRUCK) WAS GOING TO JA(K
KNOFE. 1SEE THAT THES TRANSMISSION PROBLEM IS A RECALL ITEM FOR HONDA. THE HONDA DEALER (KELLEY HONDA TN LYNN, MASS.)
SAYS THAT THEY WILL NOT HELP US FINAMCIALLY TO REPLACE THE TRAMSMISSION. THE CAR HAS 90,000 MILES AND 1S ¥ GOOD SHAPE
OTHERWISE. WE ARE VERY UPSET AT HONDAS REACTION TO THIS SAFETY FARLURE AND WE FEEL STRONGLY THAT THE U5 GOV'T SHOILD
sxsmmemum NMYMHCIEMTH “ISTRAN?ISS“L \M‘EAIS)!OTEDNTHE INTERMEY THAT THERE ARE
1 PR » F <

mnuun-nh- t.--wnb ¢ nmﬂgwhmw*ww*imm-dm

wnenirmuty. Tou we suder se shlipatise ts rospand this Yaur conpenme may be uaed o ABTL whipthae
dhanstd babs sppragrists nction be corvack » sefely defect B i NNTEA procande with mmm-m Spdingt a sanalacturer, yat feapanse.

ar o siaisutical summary Wuceal, mop b uted in aappart o the agancy's sctien,

Figure 2 — EVOQ redaction and Disclaimer placement (circled in red) example.
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Use the following disclaimer when a modification is made to the original document (redaction).

“INFORMATION Redacted PURSUANT TO THE FREEDOM OF INFORMATION ACT
(FOIA), 5 U.S.C. 552(B)(6).”

Make the disclaimer bold and place it on a separate line of the description field, top of the
document (example spreadsheet) or insert the disclaimer on the bottom of the (IVOQ)
description field, to avoid blocking more important details, when the mouse is over the
complaint file in the search result field.

H
s
1ON ACT {FOI U.S.C. 552(B){6) P
4 w;JNKAY‘ﬂEOSNDO(XXX HISSAM 08-May-04 GA
§ JNKAY41E0IMXOOOKK  HISSAN 2003 27-)ul-02 29-May-03 L
6 (INKAY41EO3MXOCOCK NISSAN 2003: 24-Jui-02 11-0ct-03 OR
T INKAYSIEQIMXXXXX  'NISSAN 2003! 27-Jul-02 28-Feb-04 CA
8 (INKAY41E03 NISSAN 2003 25-Jui-02 12-May-04:
9 JNKAY41EQ, HISSAH 2003: 25-Jui-02 18-0ct-03:NY
10 JHKAY41ES3) X\ NISSAH iM 2003 29-Jul-02 21-0ct-03 MA
J,‘ JHKAY41EO3MXOOOKK | NISSAR 2003 25-Jut-02 26-Jun-03 1)
- 12 INKAY4YEOIMOOXX | NISSAN 2003. 26-Jul-02. 15-Nov-02: CA
JQ INKAY4FEOIMXCOCXX i HISSAN I 20031 26~Jul-02 11-Sep-03
14 INKAY4LEOIMOOXX  JHISSAN 2003] 26-)ul-02 11-1ul-03 CA
15 :INKAY4 HISSAH 2003} 29-Jul-02 12-Feb-03 NY
16 (INKAY4 INISSAN 2003 26-Jui-02 16-Nov-02 . HY
17 (INKAY4 NISSAK 2003 02-Aug-02 26-Mar-03 AL
18 JHKAYY HISSAN 2003 26-Juf-02 19-Jun-03 GA
19 :INKAY4 HISSAH 2003 29-Jui-02 12-Hov-03 FL
20 :JHKAY4! HISSAN 2003 30-)ul-02 15-Dec-03:FA
»21 INKAY4REOIMIOOIXX | NISSAN | 2003 31-Juk-02 16-Feb-04 wl
22 )NKAY‘H O 3MIOOXX NISSAN ! 2003; 26-Jul-02 04-0ct-02 TX
723 JNKAY41 MIOCKKX, HISSAH 2003° 27-)ul-02 07-Feb-03.CT
4 24 {IMKAY41E HISSAN 2003: 02-Aug-02 03-)ul-03:NC
25 INKAY41EQ HISSAN | 2003: 3t-Juk-02 20-Dec-02 FL
26 INKAY41EOIMIOOOX  NISSAN | 2003/ 31-Jui-0Z 11-Apr-03 VA
27 IHKAY41EO3MXXXXX NISSAN | 2003; 02-Aug-02 30-Sep-03:VA
EZB KAY4 1EQIMXOOOX .NISSAN ?M45 N . 2003: 30-uf-02 20-Jan-03 OH
o i

Figure 3 - Disclaimer placement/XXX redaction on database, supplied on CD.

INFORMATION Redacted PURSUANT TO THE FREEDOM OF
INFORMATION ACT (FO1A}, 5 U.5.C. 552(B}){6)

& Dagint wapd AR R iy Ko
LR B it T

e
ABIRARYS on

R R 3 ]
LE AR 2R ET ]

Thamk. pms KXY pad by i vas Wy B kicomsl Haghroms: oo Satony
Kikemimintrs.con NHF%A (i"‘rdmkh‘ gamam 1 XXy g S ey § by veve
W 2P L3 “CAPOR T et Dvvil s P Bibodiy Mrmiingy of e reakyved By GLHL, we aen dee o g 1o wilk
Lot

MHEGA =« by Fobut agemy sonpaal l o mgomimg sty e e Wokion"s e eye Wi
d < vohd B 100 E] AN B vasiey Wbt o artks of sk odlinile st
b dumw shiol they v e wﬁ)} E Y L e T E T
pobmrrmcrnon. W wh e of mdl o Mm&-l-:wm;
h“ﬂlilv\vﬂrﬁﬂ-twmmhﬁm‘- sl 1 oy Wi
s 1t @1 brband e s o o v et fereamn mwnm m rrwwewyLectrory

Figure 4 - Disclaimer placement and redaction on Correspondence Response Letter.
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Note: Information is redacted based on NHTSA Chief Counsel’s finding of confidential
treatment. Usually, redactions are based on exemption 4 or 5 U.S.C. 552(b}{4). Some basis
may vary; therefore, use the appropriate numbered exemption by checking the list below
(page8).
“INFORMATION Redacted PURSUANT TO THE FREEDOM OF INFORMATION ACT
(FOIA), §.1).5.C. 552(B)(4)
“INFORMATION Redacted PURSUANT TO THE FREEDOM OF INFORMATION ACT
(FOIAL S U.S.C. 552(B)(5)

Exemptions List (Excerpt from Freedom of Information Act, 5 U.S.C §552)
Possible Exemptions;

This section does not apply to matters that are:
(1)(A) Specifically authorized under criteria established by an Executive order to be kept secret
in the interest of national defense or foreign policy and (B) are in fact properly classified
pursuant to such Executive order;

(2) Related solely to the internal personnel rules and practices of an agency;

(3) Specifically exempted from disclosure by statute (other than section 552b of this title),
provided that such statute (A) requires that the matters be withheld from the public in such a
manner as to leave no discretion on the issue, or (B) establishes particular criteria for
withholding or refers to particular types of matters to be withheld;

(4) Trade secrets and commercial or financial information obtained from a person and privileged
or confidential;

(5) Inter-agency or intra-agency memorandums or letters which would not be available by law to
a party other than an agency in litigation with the agency;

(6) Personnel and medical files and similar files which, if disclosed would constitute a clearly
unwarranted invasion of personal privacy

(7) Records or information compiled for law enforcement purposes, but only to the extent that
the production of such law enforcement records or information (A) could reasonably be
expected to interfere with enforcement proceedings, (B) would deprive a person of a right to a
fair trial or.an impartial adjudication, (C) could reasonably be expected to constitute an
unwarranted invasion of personal privacy, (D) could reasonably be expected to disclose the
identity of a confidential source, including a State, local, or foreign agency or authority orany
private institution which furnished information on a confidential basis, and, in the case of a
record or information compiled by a criminal law enforcement authority in the course of a
criminal investigation or by an agency conducting a lawful national security intelligence
investigation, information furnished by a confidential source, (E) would disclose techniques and
procedures for law enforcement investigations or prosecutions, or would disclose guidelines for
law enforcement investigations or prosecutions if such disclosure could reasonably be expected
to risk circumvention of the law, or (F) could reasonably be expected to endanger the life or
physical safety of any individual;
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PROCEDURE

A. How to Redact with Adobe Acrobat
Redaction requires performing a series of steps to apply various redaction marks that cover Pli
on a document. This first section describes the way to create an ACTION used to assign the
needed steps to a button that can then be used to apply those steps with one click, instead of
clicking several step each time the marks are to be used. Begin the redaction activity by

creating an ACTION (also called a batch sequence) button.

Note: Once the action is applied, the redacted document is considered sanitized also the
file size is reduced.

Create a New Action (Batch Sequence) Button

1. Open an Adobe Acrobat (pdf) document and select Tools, on the menu bar.

Bow A BHE @0PIDRILARTO SN
I IR {__Toon ) commem

2. Select Action Wizard and then Create New Action, The Create New Action window
will open.

» Pages

Subject: REQUEST FOR INVESTIGATION INTO BMW MOTORCYCLE FINAL DRIVE FAILURES

Brepare for Saarbuton

HTSA ccmMe outing Sl ‘
¥ mm
CL-10439549-9321 e —
Printed: 12/5/2011 i s cion o s
Actuos
NHTSA % ES11-007408 Rec'd Date: 12/572011 Referred By: NPO-011 Sppy Eadaction
XREF # Doc Type: GEN Doc Date: 11/28/2011 e Sap Docarmtts
Delivery: EXP Address To: NOAD10 Dus Date:
Coeme ucesbic STFs
s10%: DOTA £ RMP¥: et Seme G e

prisgee Sevonre: AS APPROPRIATE Signed F R
Sign Office: ENFORCEMENT Signatute: AS APPROPRI o . )
Cleared Date: Cieared By: Clearsd For: [ orepun i b
File Loc: XREF File: Closed Date: 12/87201% ere o .
Added By: CBUTLER x60180 Modified By: Chris.Butier

». Recogaise Text
WMost Recant Comment: » Pestaction

> Sign & Cartity .

» Documenk Pracessing

RS

Figure 5 - Tools, then Action Wizard.

Note: Keep the option - Start with: A File Open in Acrobat
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3. Next, add the instru

ction steps.

Create New Action

Start with: A File Open in Acrobat

Steps: Add steps from the paneis on the left.
I @ Add Instruction Step I
Save to: . Ask When Action is Sganed

of Overwrite existing files

Figure 6 — Add Instruction Step

4. Select Protection on the Create New Action menu and the window will expand,

then;

Create New Action

> Pages ..
» Content.
I | »Forms

* Recognize Text

@ Encrypt

m E Mark For Redaction

é Apply Redactions
|4 oMl Se2ich & Remove Tet
[ Remove Hidden Information

¥ Sanitize Document

* Document Processing:

Figure 7 - Open the Protection

area to move to the next step.
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5. Single click on Apply Redaction and Sanitize Document and these steps will be
added to the Steps section

[ Mtk For Redaction

4 Aooty Redactions
AR search &Remove Ten

[ Remsove Hidden Information

‘é_ Santtize Document >

-* Dotument Processing
* More Tools

Start with:  AFile Open in Acrobat, - 7

Oplions  Prompt tiser

Steps: 6 wnfdxfhn
G Sacitze Document
Save to: Mm;;!imiss;medw | ; | (T

& Overwrite ensting files

Figure 8 — Apply Redactions and Sanitize Document (add these to the action instructions).

6. Select the Document Processing drop down button and select Reduce File Size. This
will also be added to the Steps menu:

[ create New Action
DR
» Content Startwith: A FileOpenin Acrobat i LY
v Forms - o
» n l"“ ’ |"|hl Ym Optaaris, Proanpt they
> Protection Stepir o) Apply Redactions
1.7 Document Processing .
— e—r &3 Sanitize Document
B} Opmize canned POF b i ,
(& NumberPoges B tomceResie o e i
{cxj Page Transions @Md l/ ion Step
Reduce File Size . . . .
@9 setOpem Options Savetor  AckWhen Adion is Started . 8
L1 M ools of Overwnte misting files
— —

Figure 9 - Under Document Process and select Reduce File Size.
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7. Save to: Click on the down arrow and this window will open with the option to
choose where the file should be saved:
8. Choose the option: The same Folder selected at Start.

Savetor | TheSame Folder Selected at Start v B

AFolder an My Computer
mméﬁmmm«
¥ The Same Foider Selected at Start
Don't Save Changes
—

Figure 10 — Be sure to check, The Same Folder Selected at Start.

9. Click on the Save button and a Save Action Window will open then

SaVEACHON - o e e .S,z ,,,,, /
Enter Action Name:
l Enter Action Name:
Enter Action Description: Apply Redaction
Enter Action Description:
Apply Redaction
¥} Run this Action after saving Sanitize Document

Figure 11 — Enter Action Name and Action Description.

The Save Action window will look like this once the actions are inserted:

| SaveAction  sminem ) WW
| Enter Action Name:

’Apply Redaction

Enter Action Description: I

[ Apply Redaction
Sanitize Document
Reduce File Size

7 Run this Action after saving

Losee )| come |

Figure 12 — Actions entered.
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Note: DO NOT check - Run this Action after saving.
10. Select the Save button once the entries are in place.

There should now be a New Action on the Action Wizard menu called Apply Redaction

rCf.mtent

» Forms
v Action Wizard

£

% Edit Actions

Archive Paper Documents
Create Accessibte PDFs
“Z] Get Scan Doc from MFP
®Z] Prepare for Distribution
Prepate for Review
72| Prepare for Web Publishing

%l Maore Actions -~

* Recognize Text
> Protection
» Sign & Certify ,

B e e o o it s

Figure 13 — See the Action button in the lineup.

B. Begin the Redaction Process

Having created the Action Button, next:

1. Customize the Tool Bar by adding icons for the commands that will be used
regularly in the redaction process. (This will enable efficiency and save time when
redacting sometimes pages of documents).

2. To add icons to the first row of tool icons, right click on the Toolbar and choose
Quick Tools. (Figure 16).

Or, use the Tools dropdown menu choose View --> Tools --> Protection (Figure 14).
Or, use the quick tools by clicking TOOLS on the lower tool bar (Figure 16).
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@OoRLLEB

e[| 5 B

Choose Quick Tools to Add:

Quick Tools to Show:

& Tools
& Pages
@ Content
® Forms
® Action Wizard
® Recognize Text
£ Protection
Encrypt (dropdown)
@ More Protection (dropdown)
[l Mark for Redaction
g Mark Pages to Redact
6 Apply Redactions
4 Redaction Properties
A Seorch & Remove Text
@ Remove Hidden Information
&H Senitize Document

&) Sign & Certify

(@ Sticky Note
(L2 Highfight Text
[} Delete

[}) Rotate

{&) Insest trom File

-

Can't find the tool you are looking for? Find more tools undes the View menu:

View > Show/Hide > Toolbar items

Figure 15 - Follows Figure 14.
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Flo Edk Window Help ,
fRorate- | D OB | @0o2BDR
O | @ ® [ ]-]|H

+ Content
Select & Zoom + Forms
Eile v Action Wizard
Edlt ’ » Recognize Text

v Protection

Properties Bar Cri+E
- Hide Toolbars P8
_ Reset Toolbars Alt+F8

@ Encrypt v

@ More Protection v

Black Out & Remove Content -
B Mark for Redaction
Q Mark Pages to Redart
6 Apply Redactions
& Redaction Properties
4 Search & Remove Text
Hidden Information - e
@ Remove Hidden Information

&8 sanitize Document

Figure 16 - Tools --->Quick Tools ---> Protection.

Use any of these methods to open the Protection area in order to add icons for customization
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3. At the Customize Quick Tools window, click on a tool then click on the center right
arrow (as circled below). Click Ok and the icons will appear on the top row tool bar.

(Figure 18).
Customize Quick Tools
Choose Quick Tools to Add: Quick Tools to Show:
£ Tooks v [&, tnsert from Fie
g"c:; & stamps (dropdown)
2 Forms (& Sticky Note
& Action Wizsrd @ Highlight Text
& Recognize Text [ Detete
£ Protection | (3 Rotate
@ Encrypt (dropdown) ' > [ Mark for Redaction ,
B2 More Protection (dropdown) o B Mok Pages to Redct .
4 Apply Redactions -
@ Redaction Properties
& & Search &Remove Text
E @ Remove Hidden Information
&, €Y Sankize Document
Ea) Number Pages
@ Create New Action
G Sign & Certiy [ Edit Actions
15} Document Processing >
Q ;&;:ﬁwdtl‘ntodywubdmfor? Find more tools under the View menu: View >
Fride > Tookar frems (o] Ceamel )

Figure 17 - Add tools from the Protection side to the Quick tools bar.

| : CL-10392041-5895cw.pdf - Adobe Acrobat Pro BB
File - Bit. View . Window  Help 5 : T

lfac"m-l.l@al@@&-@@&@&?ﬂ@é&@@[&%@ <

! s @Lhjaing| @] HO Ik coront o prmrentronovd] ; Tools | Comment

Figure 18 - Redaction icons now on the top toolbar.
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4. Set the redaction box color to Black

Mark for Redaction -- > Redaction Properties --- > Redacted Area Fill Color --- > Choose Black

Redaction Tool Properties

€ wadartion Craie ’

e Rk

LLS FOIA
L3S Prieany St

HOTEY v I

Fucked Teloited Ertey i ;‘.»:z-?.»;c:«;}'»:«a‘

~Redaction Mark Appearance =
Outline Color: ! Fill Color: §]J

Fil Opacty: ——— [to0%

r Pk oK ! Cancel

Figure 19 — Redacted area fill color under Tool Properties.
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Redact:

1. Create a C:/Working Folder/Public folder on the C: drive to store saved files.

* PUBLIC
File Edit View Favorites Tools Help

QBack - &) F OSeach jiFoders 1 5 X ) v B & Yeravorites X
| Address & Ci\Working Folder PUBLIC o ~» Bco

;,

»

File and Folder Tasks £y

Figure 20 - Public working folder.

2. Open the document file and click on the Mark for Redaction icon, the cursor will change
to a plus sign.

3. While holding down the left button on the mouse, drag the plus sign over the area that’s
being redacted and a red square will highlight the redaction area.

R 2B OPRDYFLLAARIDRE w’
\ Tools Conwnent
; %. C,‘ 2 P F—‘- »_Pages -]
. Vﬁ e- 0 2@ & ) {'-’ Yorm Appraves: O.4.1. No. 2127-0008 2 Conten L
1 - [~
Q AUTC SAPETY HOTLING [T ‘WRE{‘CV USE ONLY » Forms.
SS%TY., VEMICLE OWNER'S QUESTIONNAIRE ;‘"MWEE \ —— » Action Wizerd
Mationst b ! [0 R —
s ey SAToncs Lissiesin SN -9 . win r.!::noferm
s 22084 : T « Protection :
CWNER WFORMATION (TYPE OR FRINT) %Ecrseﬁcgfr AEFRRENCE NG, M@ eyt
NAME and ADORESS GAT1g 457 ) ’
o B More Protection .
acag] mvnuew“o,mw:m N Btack Out & Remove Content
[£7853 97352 T B o een
rrmmdmumum-mdmm-mm“mmg wo ] @ merk Pages to Redact
SIGNATURE OF OWNER] - - A Mooy Redactions
E— b e 4275
TION . A Redaction Properties
VEHICLE IDENTICA "
EHICLE TONNO." 1y £ 0 5~ T~ | VENICLE MAKE MODEL NOOEL YEAR Ay seach & Remove Text
recays Treelo i — N . QU IEL D :

Figure 21 - Mark for Redaction.
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4. Click Apply Redaction. This will create a black box where the redlined selection was
made.

% 457203.pdf - Adobe Acrobat Pro
File Edit View  Window Help

Boae- DB SR B L OCPRDITLLH4.9DB B

G @ | RO =@ =]
o

»—

n he sbeence of en
SIGNATURE OF

o 72¢€

{ ) qiry

\/ﬁ e O 2 ;-& & 4 M) { - Form Appeored: O.M.8. Ne. 21IT-0008

. FOR AQENCY USE ONLY
‘. AUTO SAPETY noTUNE -y
SETEL VEMICLE OWNER'S QUESTIONNAIRE 'y e NeSe Uy E T e
'm“ :vm&um.” 7 JL'W -8 AHII: o :-:’ : :
OWNER INFORMATION (TYPE OA PRiteT) oy rs‘;;’;fCE REFERENCE NO,
NAME and ADORESS ESTican 457203

B2 more Frotection .

hm%m.m-mdmmhhmdmﬂtmg IOD

OF 3ddress 1o the vehicie

1
DAY TIME TELEPHONE NO. (AREA COOE)

Black Dut & Remave Content
[ Mark fox Redtaction

@ Mok Pages to Redact

TION

[uarﬁz ) £ )
w253 A Redachon Propertes

VEMICLE ID€! ™ .
: DENTIFICATION NO.* /7, [0/ & 70~ | VEHICLE MAXE T MOCEL YEAR o seach s Remove Text
CCALL NORpaln ®reeles N : ¢ 3I9FC A )

| [LOCATED AT SOTIOM OF WOOBNELD (i COReers are 7»41 Ll 2 i L& L L "

Figure 22 - Redaction applied, redaction area is now covered with a black box.

2

BLUE BIRD
TRy

November 30, 2007

Office of Defects Investigation

1200 New Jersey Ave
Washington DC 20590

National Highway Teaffic Safety Administration

PEO7-050
NVS-2145im

Figure 23 - Another example of redaction applied area covered with a black box.
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5. After all of the redaction marks have been applied, permanently redact the entire page
by selecting the OK button (Figure 10).

A (’*:Bz’: Aciobat

Flle " Edit - View  Window Help . e : e : l
Beae- DR 2R OCPRDRFLLALABRIDE R o

[Mark contant for permanent mmvd'

Adobe Acrobat

O\~ (0390645( 1@ Radactons have been accessfly eopled.

Would you 850 ike to examine your document for addiional dogument
information?

) Abways pestorm the selected acton PH g: 58

(= lissiON

BETHESDA, MARYLAND 20814-4408
Aberta E. Mills Tel: 301-504.7479
Freedom of Information Officer Fax; 301-504-0127
Division of Information Managemant « Offics of information and Technology Emall: amils@cpsc.goy

December 24, 2009

Figure 25 - Final redaction screen.

6. Redaction has been successfully applied. Would you like to examine your document for
additiona! document information? Select NO. Continue on to save the redacted
document.
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% CL-10392041-5895¢cw.pdf - Adobe Acrobat Pro
File Edit View. Window Help

fam- 166-!@@&@@BBZS¢44@@B@@

INFORMATION Redatte
@Y NFORMATION & -
Save As
Savein [ €3 PUBLIC N O o

'.3 BINOT-PEIS045-3801 1.pdf
by ¥ B INOT-PEGB0S5- 38620 pdf

Figure 26 - Save icon and file window.

7. Select the Save icon or use File --- > Save As.
8. Then select Save.

9. Select Yes. The file will be saved in the same location as the original file (C:/Working
Folder/Public).

\z) C\EQ-10229712-2653 pdf
The file already exists.
Replace existing flle?

s LN |

Figure 27 — Click Yes to save.

Note: Once files have been redacted and quality controlled by another individual, files
are then uploaded to the Public or Private Repositories of the Artemis Database, where
they are viewable by the public or within NHTSA. The process for this upload is
explained in detail in the Scanning SOP. Access to other SOP's discussed in the
Reference section of this document.
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C. Other Examples of Redaction

The areas marked in black below show where information was redacted (figures)

SR Detail (Query)

SR Number: 1-12424386  timing chain/valves

Contact Name: _

Contact Role: Owner
Account/Rtir;

City: Winneconne State: wi

Postal Code: _ Country: USA

Work Phone: Home Phone: —
Emaii:

VIN: 168ss52FsY YN

Mileage: 67.000

Working Rtir:  (10076) Satum of Appleton

Figure 28 - Redacted PII.

(110392041 5895cw, pdf - Adobe Acrobat Pro -5}
Fle Edit View Window' Hsb . i *

Agnid Raas thn. WA Ny B
Nostunp Mgy Tais Nabvy

St Vvt Wadar Compuny
dmney Otk 3. L W, Cang, Ui, Samasies Solily {8he:
Sax Cu SRS

. s
Sy 3, VY Gnongls mga 34, VS, Tow 7 g wos vievmg pigiad mminiins

WAt 1o ot g PR s s sl T oo o

ot Sfn

vy

Toun il A R silbosertatgarnd e o Sy
omig it e of i gt S Smpmanal s, = vy b
i s  S———

0 ety o bl e w—
oy oy vy
s ' v .

:':." e
1. mhu.uuuu— -tug-..,q—.u-u
-G et by imasry .

P St Vol Ao (Y Y STH
*\ = I i, i o £33 Tt 322%
- AN T M
Sl gl Die-igut

Figure 29 — Redacted PII.

Note: When redacting an IVOQ document only, if a VIN number is found in the
complaint description in part or whole, confirm or copy the VIN to the VIN field in
Artemis and remove itand its label “VIN” from the complaint description.
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POWER TRAIN: 32010 - WENTIVELE, MO

DRIVELINE MY ISSUES OCCURRED 5 YEARS AGO, [T WAS THE FIRST YEAR TOYOTA USED THE COMPUTERIZED ACCELERATION IN THEIR
CARS THIS INFORMATION IS IMPORTANT TO THE INVESTIGATION BEING CONDUCTED BY NASA FEBRUARY 21, 2005 WE
PURCHASED A BRAND NEW TOYOTA SOLORA BY JUNE WE SOLD IT. THE CAR FAILED TO ACCELERATE ON SEVERAL
OCCASIONS BY NOT RESPONDING WHEN t PUSHED THE OAS PEDAL | REALIZE THIS IS THE OPPOSITE END OF THE
SPECTRUM, BUT TRUST THAT IT IS RELEVANT. PLEASE ENSURE NASA GETS THIS INFORMATION IT WILL GVE THEM MORE TO
WORKWITH. | AM WRITING YOU TODAY BECAUSE FOLLOWING A NEWS BROADCAST ABOUT TOYOTA MY CHILD ASKED ME IF |
REMEMBERED OUR INCIDENT THAT ALMQST COST US OUR LIVES IN THAT CAR. | HAVE PLACED THIS INFORMATION IN YOUR
HANDS TO DO THE RIGHT THING WITH. VINS 4Tt CAZ0PISUE561%) CASE NUMBERS ON FILE WITH TOYOTA 200504110025 -
APRIL 11, 2005 200505090783 GMAY 9, 2005 2605051 20765 - MAY12, 2005 THE ISSUES WERE FIRST HANDLED AT THE
DEALERSHIP LEVEL WHERE THE VEHICLE WAS PURCHASED, BEFORE | REALIZED THERE WAS A SERIOUS SAFETY ISSUE
WITH THE VEHICLE. If YOU HAVE ANY QUESTION| CAN BE REACHED A'rfummnmuags

Source: NHTSA Website

Figure 30 — X’s used to redact PIl.

esj <] "‘J £iq% REQUEST NUMBER TWO DATAXS [Compathbility ane‘; - Microsof: Exce!
Home 1 i : : J ( - . T
y ; :11 [ Genern . m % Normel 2 Normal 22 Normal 3 | Normal i ,Z']J'
51 et perter | WO O] 3 Mivge & Cenien v :;; RTE = ) Londionst Foraat - Bsd Good Neutrat edstion | e
Chpbasis = . Avgriment. o Nomber i sther
o e e estpan -

4 S W SRS SRS BRSSO < e o . PURRRETY e £ -SRI SR - N A
1 VW Flie Number Category Vehicle Owner Name Vehlcle Owner Address Vehicle Owner Phone VIN Make
2 90187358 Consumer Complaint REDACTED REDACTED REDACTED IVWAJSTIKTZMXXXXXX  Volkswagen
3 90198558 Consumer Complaint BEDACTED REDACTED REDACTED VWALTLKIIMIOOOXX  Votkswagen
4 90176126 Consumer Complaint REDACTED REDACTED REDACTED 3VWALTIKAIMIOUOOK  Voikswagen
5 90180143 Consumer Complaint REDACTED REDACTED REDACTED IVWALTIKGIMOOOXX  Volkswagen
3 90177845 Consumer Complaint REDACTED REDACTED REDACTED IVWALBIKXIMXXXXXX  Volkswagen
7 50161183 Consumer Complaint REDACTED REDACTED REDACTED IWBATIKTEMIOOOOX  Volkswagen
8 90190664 Consumer Complaint REDACTED REDACTED REDACTED IVWEBITIKZBMIOOXXN  volkswagen

: 30195104 Consumer Complaint REDACTED REDACTED REDACTED IVWRITIKXBMXXXXXX  Volkswagen
10 50180990 Consumer Complaint REDACTED REDACTED REDACTED IVWOLTIKOIMXO0OX  Volkswagen
i 90150735 Consumer Complaint REDACTED REDACTED REDACTED IVWCLTIKOIMXXXXXX  Volkswagen
12 50190724 Consumer Compiaint REDACTED REDACTED REDACTED 3VWCLTIKIIMIOOOXXX  Voikswagen
13 90185521 Consumer Complaint REDACTED REDACTED REDACTED 3VWCLTIKZIMXXXXO.  Volkswagen
b 80323358 Consumer Complaint REDACTED REDACTED REDACTED IVWCLZIK2IMEXXXXX  Volkswagen
15 50181082 Consumer Complaint REDACTED REDACTED REDACTED IVWCLTIKISMXXXXXX  Volkswagen
i 50155879 Consumer Complaint REDACTED REDACTED REDACTED IVWOLTIKEIMXXXXXX  Volkswagen
17 90189804 Consumer Complaint REDACTED REDACTED REDACTED 3VWCLTIKEIMXXUXXX  Volkswagen
18 90180745 Consumer Complaint REDACTED REDACTED REDACTED IVIWCLZIKTIMXXXXXX  Votkswagen
19 90180992 Consumer Complaint REDACTED REDACTED REDACTED IVWCLTIXBIMXXIXXX  Volkswagen
20 90178657 Consumer Complaint REDACTED REDACTED REDACTED IVWCLZIXEIMOXXXX  Volkswagen
2 50190656 Consumer Complaint REDACTED REDACTED REDACTED 3VWCLZIKIIMXXXXXX  Volkswagen
2 90189189 Consumer Complaint REDACTED REDACTED REDACTED 3VWCL7IKXIMXXKXXX  Volkswagen
2! 50100730 Consumer Complaint REDACTED REDACTED REDACTED IVWDI7IKOEMXXXXXX  Volkswagen
b2} 90191534 Consumer Complaint REDACTED REDACTED REDACTED IVWDI7IKEBMXXXXXX  Volkswagen
25 90189422 Consumer Complaint REDACTED REDACTED REDACTED 3VWDI7LK7BMXXXXXX _ Volkswagen

Figure 31 - Example of PIl redacted in a Pursuit document (an Excel spreadsheet).

Note: For Pursuit documents only; replace the Name, Address and Phone Numbers with
the word "Redacted". Use 'XXXXXX' on the last 6 numbers of the VIN (Figure 31).

Pull the Pursuit Information spreadsheet from the CD (provided by Engineer).
Redact PII as indicated above.

Add Disclaimer (see Figure 3).

Create a password (to prevent any further changes to document) by; Save as ---
Tools --- General Options --- Read Only --- type password (3 letter code) --- OK ---
repeat password --- Save

5. Save redacted copy to the, previously created, desktop folder on hard drive
(specifically for Pursuits).

PwnPR
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6. Save a copy to the Pursuits QC folder on the DOT network. (Save an original copy to
the QC folder also).

7. Create a Tracking Number (for Artemis) and upload to the Public Repository.

Return CD to Engineer.

9. IKfdocit too large (over 25mb) save redacted file to a CD, create a slip-sheet and pass
to the Investigation Case Assistant to handle further.

%

Note: The 3 letter password is created by the Document Handler via a personal system.
(Discuss with management).
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L BT AN TSRS T .
e DOT Auto Safety Hotline FOR AGENCY USE OMLY 100148
US. Department Vehicle Owner's Questionnaire Dote Received Reposttory [
of Trangpostation To Report Vehicle Safety Defects
1-888-DASH-2-DOT
Mational Highway 1- 22 1%-1LH- 2010 Refeoance No.
Trafthc Satety . (1-888-327-3236)
Administration INTERNET:www.niitsa.dot.gov /hotline bt aad
OWHNER INFORMATION (Type or Print}
Name .0 STODDARD Doytine Tebephane Numbes | E-mail Address
781-635-1934 NSBOSTQADLCOM
AGHress <7 pinpMENT AVENUE _ - "
Y cwamescotT Is‘“‘ MA Iz‘p Code 51007 780-558-1444
The information mmummm [ safaly-raletud duiacts. Wa may SVare pour information with the
appickdla Snufactuner diwing s investip oF recel it secordine i M usas dascribad in the apascy’s Privecy Act
sotice, Ses 49 Fl WI Sap. 3, 2&}-
YEMICLE INFORMATION
17 digh Vehioe Tdentfication Number Located st battom of windshisd on drivar's side | Maka Modai Hodel Year
THOEMSESXAMDDTE0E HONDA ACCORD 2004
Dute Purchased Dealer's Hame 2nxt Telephooe Kumbar Engine; Faal Type:
Mo: Oyinders 6
Criginal Cwnee Dealers City State T Code
Trargaission Type ] Anthock Brakes] Powartrain Huttipie Falure. Trciant Dabe(s}
[ cruse Control X 10-1U0-2010

FAILED COMPOMENT{5)/PART(S) INFORMATION
Vahicle Companam Code: 103000 POWER TRARN: AUTOMATIC TRANSMISSXON

Failuro Minage | Falure Speed
1000 6l

Tive Make I Tee d (lem or W) ) rn Slu (Emh P215/65R15)
OO Fo. (Exampie: DOTHALIABLI3S) [m .

=1 Pnl'r?;-m:l E“‘m I Faiure Location:
T mpanent Lode

veto Tire Falure Type:
ADDITIONAL ITEMS TO BE COMPLETED WHEN REPORTING A CHILD SEAT FAILURE
Makn: Date Martactured: Modet Ho. /Nasme:
Set Type: Ingtallakion Systerc
M Seat Component Code: Faded Pact:
gy} T T TRy T A
Anucuu THCIDENT HIFORHAT!W
sen iin asivas) ip<i §

Crash Fire MmMMnmlnlumd WMM& mem

| [yes [X] mo
Marraties Doscription of Incitans{S), Crashi{es), and Djurylins).

Manse describe {1} swvents laading up (o the failurs, ;2] fallure ned s consajuenca, aind (3) what wis done to cerreck thve fallure;
fi&, parts rapaired ow sigliced {and if old poet is avalabla).

WE WERE LUCKY THAT WE WEREN'T KILLED®12004 HONDA ACCORD EXL VIN#LOK].
BOSTON IM THE MIDDLE LANE AT AN APPROX. SPEED OF 60 MPH ON JUNE 10

WERE TRAVELING ON ROUTE 95 NORTH OF
ROX. 6:15PM. 1T WENT TO PASS THE CAR IN FRONT

OF US AND STARTED TO PULL INTO THE PASSING LAME OM THE LEFT. SUDDENLY, THE CAR JERKED VICLENTLY AND SLOWED DOWN
SUDDERLY. THE CAR IN BACK OF US ALMOST HIT US AND SWERVED ERTO THE LANE O THE RIGHT TO AVCID HITTENG OUR CAR. THE
CTHER DRIVER WAS ALMOST RUN OVER BY A SEMI TRUTK WHO JAMMED ON HIS BRAKES. [ THOUGHT HE (THE YRUCK) WAS GODENG TO JACK
KNIFE. 1SEE THAT THES TRANSMISSION PROBLER IS A RECALL ITEM FOR HONDA. THE HONDA DEALER (KELLEY HOMEM IN LYNN, MASS.)
SAYS THAT THEY WILL NOT MELP US FINAMCIALLY TO REPLACE THE TRANSMISSION. THE CAR HAS 90,000 MILES AND IS M GOOD SHAPE
OTHERWISE, WE ARE YERY UPSET AT HONDA'S REACTION TO THIS SAFETY FARLRE AND WE FEEL STROWGLY THAT TH

£ US GOV'T SHOARD
RET-SHERE ARE

'I'l-ﬂh-vldd ml-h“l u-n-nn\- i d

huH'uMth““IWMSMln‘M
swmdments, You e snder wo ol L, d Your ramy bs uoed t» savist the NETIA in
dhauls isks apgropriste sctisn ba cervsct uaﬂn:ﬁbclnml AHTEL provea s wikhs L apains reur
o B sislisticel summary Waresd, may ¥ wnnd in mppert of the aganty's sclion,

Figure 32 - Example of VIN# and Pll redacted in an IVOQ document (in Artemis).
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IX. DEFINITIONS

A

Artemis - Advanced Retrieval, Tire, Equipment and Motor Vehicle Information System, a
Database and Image Repository system developed to enable FTE managers, writers, screeners,
analysts, investigators and engineers to store and maintain data and meet reporting
requirements based on the data.

Artemis Image Repositories (Private and Public) - The storehouse of ODI documents and
records, the Repository is used by Administrative Support to: review Consumer
Correspondence source documents, extrapolate requisite information and enter the
information into the corresponding records in the Artemis Database. Perform Quality Control
checks of Correspondence entered into the Artemis Database for grammatical; spelling,
redaction of Pl (Public) and data entry errors. The Private (Internal) Repository is used ‘in
house’ by FTE and contractors; the Public (External) Repository is accessible via the Internet.

C
Confidential Material -

Congressional Letters - One of the many types of documents which arrive by mail and come
from members of Congress speaking on behalf of their constituents or requesting information
regarding safety related defects. Congressional Letters require Top Priority Processing, as they
MUST be responded to within 3-4 days after receipt.

Consumer Letters - Consumer Letters received in the mail and through the Internet contain
requests for information, report defects and/or identify recall problems. Consumer Letters
require Priority Handling, include;-but are not limited to: Letters from Consumers, Freedom of
Information Act (FOIA) Requests, Email Consumer Letters and Email Consumer Forms.

D

Data Entry - Staff enter information on Complaints and Technical Service Bulletins into the
Artemis Database, they also prepare Technical Service Bulletins for Scanning into the Artemis
image repository.

Disclaimer -

E

Email Consumer Form - Emailed to ODI through the Internet, identified by the ODI Manager’s
name printed on the top left corner of the email. Email Consumer forms are processed as
Consumer Letters.

Email Consumer Letter - Emailed to ODI through the Internet, identified by being formatted
like a memo, example: From: Consumer’s email address, To: ODI Manager and Subject.
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Public Viewing (Redaction) SOP

F
File Name - assigned by the person scanning the documents.

FOIA - Freedom of information Act, for redaction, a single page is inserted

that reads: THE ATTACHMENTS TO THIS DOCUMENT HAVE BEEN REMOVED TO PROTECT
UNWARRANTED INVASION OF PERSONAL PRIVACY PURSUANT TO EXEMPTION 6 OF THE
FREEDOM OF INFORMATION ACT (FOIA), 5 U.S.C. 552(B) (6).

FTE — Full Time Employee (Federal)

|
Internal Repository (Private) - data storage and retrieval area in Artemis for internal use only

Internet Vehicle Owner’s Questionnaire - (IVOQ) Requests — Complaints generated by
Consumers who use the NHTSA website to report problems with their Vehicles, Tires,
Equipment and/or Child Restraint Systems if applicable

M

Mailed-In Vehicle Owner’s Questionnaires - (MVOQ) Questionnaires Consumers use to
report problems with their Vehicles, Tires, Equipment and /or Child Restraint Systems include:
Vehicle Owner’s Questionnaires, Optical Marked Vehicle Owner’s Questionnaires Child Safety
Seat Questionnaires and Ohio Turnpike Crash Reports.

(o)
ODI - Office of Defects Investigation

ODI! Number - An eight-digit number automatically assigned a document when entered into
Artemis.

Optical Marked Vehicle Owner’s Questionnaire - Optical Marked VOQ- A Questionnaire,
distinguishable by ‘penciled-in’ responses, the Consumer uses to report problems with their
Vehicles, Tires, Equipment and/or Child Restraint Systems.

OVSC - Office of Vehicle Safety Compliance (NHTSA)

P
Petitions -

Pll — Personally Identifiable Information (Name, address, Social Security Number etc.)

Police Report - A Report taken by law enforcement officers regarding a vehicle accident or
defect resulting in a traffic hazard. When applicable the Report can include information on the
consumer, fatality, personal injury, property damage, weather conditions, primary causation
factors and accident and fatality ratios.
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Public Viewing (Redaction) SOP

Public Repository (External) — Artemis’s data storage and viewing available to the public.
Pursuit — An investigation operation regarding a vehicle defect that leads to a death or injury.

Q

Quality Control — checks for spelling, grammar, possible data entry mistakes and Pll and
Disclaimer statement on documents entered into Artemis by Data Entry Staff, Vehicle Safety
Hotline staff and Public.

R
Recall - Correspondence between vehicle {parts) manufacturer and consumer where defects
may require repair or replacement sponsored by the manufacturer and reported to NHTSA.

Returned EVOQ Complaint - an EVOQ Complaint ‘Returned’ by the Consumer which may
contain additional (written) information about the Complaint and supporting documentation
such as letters, invoices and/or pictures attached to it.

Redaction marks -

S
Sanitized document -

Slip sheet - a bar-coded form generated within Artemis that identifies correspondence logged
into the Artemis Correspondence Module. The Slip Sheet is attached to the document and
sent to the Scanning Station.

T
Technical Service Bulletin (TSB) - Manufacturers are mandated by law to provide NHTSA with
the same Product Recall, Defective Product Component and Service Campaign information
that they send to their Vehicle, Equipment, Tire and Child Restraint System Dealers. This
information is distributed in a variety of formats; Emails, Letters, Newsletters, Pamphlets,
Books or Computer Disks (CD). They are clearly marked with Vehicle, Equipment, Tire and/or
Child Restraint System Manufacturer logos.

\

Vehicle Safety Hotline - public available phone line to enable consumers to call and place a
complaint regarding a possible safety issue with their vehicle requiring NHTSA to respond or
collect data for trend or manufacturer information

VOQ - Vehicle Owners Questionnaire received in the mail from the consumer the form is
identical to an EVOQ Complaint or Returned EVOQ except for the fact that all the information
given is written on the form by the consumer.
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X. REFERENCES

Other related SOPs available on the Enforcement Document Library/Contractor Resources/ site:
http://our.dot.gov/office/nhtsa.nvs/NVS-200/enforcelib/default.aspx

® Scanning SOP
* Quality Control SOP
* Pursuit SOP
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CENTER ror AUTO SAFETY

1825 CONNECTICUT AVENUE NW  SUITE 330  WASHINGTON DC 200085708 OFFICE QF CHIEF COUNSEL
202-328-7700 <4 www.3utosalfetly.org RECE‘VED

015 KOV 10 A G 12

November 4, 2015

VIA FAX AND FIRST CLASS MAIL

National Highway Traffic Safety Administration (NHTSA)
Executive Secretariat

1200 New Jersey Ave. SE

West Building

Washington, DC 20590

FOIA REQUEST
Dear FOIA Officer:

The Center for Auto Safety (“CAS”) files this request pursuant to the Freedom of
Information Act (“FOIA™). CAS is a nationwide nonprofit consumer advocacy
organization established in 1970 by Consumers Union and Ralph Nader. CAS works
toward improved safety, environmental responsibility, and fair dealing in the automotive
industry and the marketplace.

CAS seeks the following information:

The entire document containing the attached table, “Information to redact or
not redact according to the document type.” The full document is likely a
memorandum on NHTSA redaction policy issued by Chief Counsel or by the Office
of Defects Investigation.

CAS believes that the requested records are likely to be located within the Office
of Defects Investigation, the Office of Chief Counsel, and/or the Office of the
Administrator. These documents may include electronic as well as paper records. Also,
pursuant to S U.S.C. § 552(a)(4)(A) and U.S. Department of Transportation regulations
set forth at 49 C.F.R. § 7.44, CAS requests, and NHTSA should grant, a waiver and/or
reduction of fees for processing this FOIA request, including search, review, and
duplication charges, for the reasons given below.

49 C.F.R. § 7.44(a) and (c) provide that a fee is not to be charged for the first two
hours of search time or the duplication of the first 100 pages, “unless the records are
requested for commercial use.” In addition, 49 C.F.R. § 7.44(d) states that review fees
for determining whether the requested records are exempt from mandatory disclosure
may not be charged when records are not requested for a commercial use. The above
information request is of a very limited and highly specific nature, and CAS believes that
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these records have no commercial value whatsoever. Even if the requested records had
some potential commercial value, CAS has no commercial purpose or interest in
requesting them. See Attachment A. Therefore, NHTSA should fully apply the
subsection (a), (c) and (d) allowances to this request.

Should NHTSA deny the waiver of fees, CAS asks that the Agency to obtain
authorization from CAS before delivery of any materials. If the agency refuses access to
any of the requested records, please describe the materials it wishes to withhold and
specify the statutory justifications for the refusal. Also, please state separately NHTSA’s
reasons for failing to invoke its discretionary powers to release the materials in the public
interest.

If you have any questions about the scope of this request, or if you believe there
are any ambiguities in the way CAS has framed its request, please let me know as soon as
possible.

CAS looks forward to a response within twenty working days, as required under

the FOIA, and will interpret any delay in response as a denial of this request. Thank you
for your very prompt attention to this matter.

Sincerely,

wia

Michael Brooks
Staff Attorney

Attachment(s): 2



CENTER FOR AUTO SAFETY

1825 Connecticut Avenue, NW Suite 330 Washington, DC 20009-1160 (202) 328-7700 Attachment A

MISSION STATEMENT

The Center for Auto Safety (CAS) is a nonprofit research and advocacy organization founded by
Consumers Union and Ralph Nader in 1970 to provide consumers with a voice for auto safety and quality in
Washington, D.C. and to assist owners of "lemon” vehicles to file complaints and obtain relief. Although
CAS has a staff of less than a dozen people, its work is supported by approximately 20,000 members across
the United States, and it is nationally recognized as a leader in the areas of automobile safety and consumer
protection.

CAS vigorously supports economically feasible motor vehicle safety policies that will reduce the risk of
crash-related deaths and injuries. CAS serves as an important counterweight before federal policymakers to
the automobile industry, whose positions on these safety issues are dictated by the desire to maximize
profits for shareholders rather than to strike the proper balance between safety and other vehicle features.

In fulfifling its mission, CAS is engaged in the following activities:

X Researching defects in motor vehicles and monitoring defect investigations conducted by the
National Highway Traffic Safety Administration (NHTSA) and other federal agencies;

X Obtaining information on potential vehicle safety defects from consumers, alerting NHTSA to
these problems, and requesting that NHTS A undertake investigations;

X Responding with comments to agency rulemaking proposals and other initiatives that affect motor
vehicle safety;

b

Supporting motor vehicle safety legislation before Congress, including testifying at public hearings
and advocating with members of Congress and their staffs;

X Monitoring enforcement of federal vehicle safety laws by NHTSA and other federal agencies;

X Fumishing consumers with free information packets that detail the performance and safety
problems of vehicles by make, model, and model year; and

X Providing free information to consumers about state "lemon laws" and automobile manufacturers
"secret warranties” (where the auto manufacturer has an internal policy to pay for repairs beyond
the limits of the express warranty) to assist consumers with complaints against manufacturers or
dealers.

A key pillar of CAS's mission is actively to disseminate the information that CAS gathers to the public so
that consumers are better informed about motor vehicle safety issues. CAS regularly distributes a
newsletter to its 20,000 members. CAS is also establishing a website that will provide information on a
range of motor vehicle safety topics. In addition, because members of CAS's staff are recognized as ieading
experts on motor vehicle safety, CAS officials regularly appear on television and radio, and they are
frequently quoted in the print media. CAS staff members also write op-ed pieces for national and local
newspapers. Finally, CAS forms coalitions with some of the nation's leading individual and organizational
advocates for motor vehicle safety, and CAS encourages these safety leaders to disseminate the information
gathered and produced by CAS to their memberships and contacts. These other organizations, such as
Public Citizen and its approximately 100,000 members, Consumers Union, and the Consumer Federation of
America, routinely utilize information and analysis provided to them by CAS.



Table 1. - Information to redact or not redact according to the document type

Document Types

Consumer
Complaints/
Correspondence
letters/Congressional
letters/Petition
letters/Newspaper
excerpts/Other
supporting documents

Information Redacted

Names

Street addresses

Zip or postal codes

Social Security numbers

Dates of birth

Ages

Driver’s license numbers

Family/friend names
Facesfinjuries/deceased bodies in photos
Car tags or license plate numbers
(private vehicles only)

Phone numbers — home, business, fax
and mobile numbers

Signatures from the consumer, family,
friends, or witnesses

Insurance claim numbers

Insurance policy numbers
Warranty/Invoice claim numbers
Junkyard/Insurance claim centers stock
numbers (usually painted on vehicles)
Bank account numbers

Credit card numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

VIN barcode (part of barcode)

Citation numbers

Police accident report case number
Court reference numbers

Website address or URL

Not Redacted

State

City

First 11 characters of
VIN number

Car tags or license
plates of commercial
vehicles

Names and
addresses of parties
acting in their official
capacity (e.g., lawyers,
doctors, automobile
dealers, automotive
service businesses,
police officers, EMT,
coroners, nurses,
government officials,
judges etc.)
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Death Certificates, Autopsy
Reports or other
information related to
deceased individuals

Names

Street addresses

Zip or postal codes
Social Security numbers
Dates of birth

Ages

Driver's license numbers

.{ Family/friend names

Faces/injuries/deceased bodies in photos
Car tags or license plate numbers
{private vehicles only)

Phone numbers — home, business, fax
and mobile numbers

Signatures from the consumer, family,
friends, or witnesses

Insurance claim numbers

Insurance policy numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

VIN barcode (part of barcode)

Citation numbers

Police accident report case number
Any unique identifier for death
certificates/autopsy reports {e.g. Report
number)

State

City

First 11 characters of

VIN number

Car tags or license

plates of commercial vehicles
Names and

addresses of parties acting in
their official capacity (e.g.,
lawyers, doctors, automabile
dealers, automotive

service businesses,

police officers, EMT,
coroners, nurses,
government officials,

judges etc.)

Medical Records, such
as, doctor reports and
medical reports

Replace with disclaimer page
(See page below)

Replace with disclaimer page
(See page below)
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Police Accident Reports

Names

Street addresses

Zip or postal codes

Social Security numbers

Dates of birth

(ncident dates

Ages

Driver's license numbers

Family/friend names

Faces/injuries/deceased bodies in photos

Car tags or license plate numbers
private vehicles only)
hone numbers — home, business, fax and

mobife numbers

Signatures from the consumer, family,

friends, or witnesses

Insurance claim numbers

Insurance policy numbers

Bank account numbers

Credit card numbers

Last 6 digits of the VIN

Foreign VIN last 6 digits

E-mail addresses

VIN barcode (part of barcode)

Citation numbers

PAR case number

Mile markers

Street names (where the accident

occurred, in pictures/diagrams/narrative)

State

City

First 11 characters of

VIN number

Car tags or license

plates of commercial vehicles
Names and

addresses of parties acting in
their official capacity (e.g.,
lawyers, doctors, automobile
dealers, automotive

service businesses,

police officers, EMT,
coroners, nurses,
government officials,

judges etc.)

Work Orders/Repair
Invoices/Warranty )
Information/Insurance claims

Names
Street addresses
Zip or postal codes
Social Security numbers
Dates of birth
Ages
Driver's license numbers
Family/friend names
Car tags or license plate numbers
g)rivate vehicles only)
ustomer phone numbers — home,
business, fax and mobile numbers
Signatures from the customer
Insurance claim numbers
Insurance policy numbers
Bank account numbers
Credit card numbers
Last 6 digits of the VIN
Foreign VIN last 6 digits
E-mail addresses
VIN barcode (part of barcode)

State

City

First 11 characters of

VIN number

Car tags or license

plates of commercial vehicles
Names and

addresses of parties acting in
their official capacity (e.g.,
lawyers, doctors, automobile
dealers, automotive

service businesses,

police officers, EMT,
coroners, nurses,
government officials,

judges efc.)
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Lawsuit Documents
(Depositions, complaints, other
supporting documents etc.)

Names
Street addresses
Zip or postal codes
Social Security numbers
Dates of birth
Ages
Driver’s license numbers
Family/friend names
Facesl/injuries/deceased bodies in photos
Car tags or license Flate numbers

rivate vehicles only)

hone numbers — home, business, fax and
mobile numbers
Signatures from the consumer, family,
friends, or witnesses
Insurance claim numbers
Insurance policy numbers
Warranty/invoice claim numbers
Junkyard/Insurance claim centers stock
numbers (usually painted on vehicles)
Bank account numbers
Credit card numbers
Last & digits of the VIN
Foreign VIN last 6 digits
E-mail addresses
VIN barcode (part of barcode)
Citation numbers
Police accident report case number
Accident incident date
Mile markers
Street names (where the accident
occurred)
Pl in lawsuit caption if Pll is of individuals
not acting in official/commercial capacity
Court reference number
Witness PIi: e.g. name, address,
telephone, DOB, faces, signatures etc.

Lawyers involved in the lawsuit
Names and addresses of
commercial organizations
Names and

addresses of parties acting in
their official capacity (e.g.,
lawyers, doctors, automobile
dealers, automotive

service businesses,

police officers, EMT,
coroners, nurses,
government officials,

judges etc.)

Petition information found in

pursuits {i.e. DP investigation

files

Petitioner’s address (including city and

State)

Telephone number

Zip or Postal Codes

iocial Security numbers Dates of Birth
ge

Driver's License numbers

Family/Friend names

Third-party names and witness information

Street Addresses

Faces/injuries/deceased bodies in photos

Car tags or license plate numbers Phone

numbers — home, business, fax and mobile

numbers

Signatures from the consumer, family,

friends, or witnesses

Insurance claim numbers

Bank account numbers

Credit card numbers

Last 6 digits of the VIN

E-mail addresses

Foreign VIN last 6 digits

VIN barcode (part of barcode)

Petitioner's Name(s)

Names and

addresses of parties acting in
their official capacity (e.g.,
lawyers, doctors, automobile
dealers, automotive

service businesses,

police officers, EMT,
coroners, nurses,
government officials,

judges etc.)
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